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The Writing Center

1 Introduction page
Here you'll find out how to use this Quick Reference,

install the program, get help, and order complete

documentation from The Learning Company.

2 Quick Lesson page 7

Ready to get going?  This easy lesson will get you off
to a fast start working with text, graphics, and page

setup in a sample document.

3 For At Ease Users page 25

If you are running the program under At Ease, come
here for important information.

4 Troubleshooting page29

Having trouble?  Check here first for answers.





1 Introduction
Welcome to The Writ ing Center !  This Quick Reference is

designed to get you started with the program and help you

produce your very first document. It also contains helpful
information on running under At Ease, and provides solutions

to problems you might encounter while using the program. On

the next five pages, you'll find instructions on how to install

the program (if it isn't already installed on your hard disk),
how to get on-screen help, and how to order the complete

User's Guide for a full explanation of every feature of the
program.

Quick Lesson is a short lesson on how to use The Writing

Center. You'll learn how to start the program and use many of

its most powerful features. Using a sample report, you'll work

with text, graphics, and page setup, and you'll learn all the
basics you need  to  ge t  s ta r ted  on  your  own  documents .

For At Ease Users provides important information for users

running under At Ease instead of the Finder, including how to

set  up  the  program af te r  re insta l l a t ion  and  how to  change  the

default picture folder.

Troubleshooting l ists common problems that you might run

into and provides solutions.



1 INTRODUCTION

INSTALLING THE PROGRAM
If The Writing Center has already been installed on your hard

disk, you wil l  see a folder called The Writing Center. Skip this

section and go on to Getting Help. If you need to install the

program, follow the appropriate instructions below (for the

floppy disk or CD-ROM version of the program).

Installing from Floppy Disk
The installation process expands the compressed files to their

normal size and places them in a folder it creates on your hard
disk. You wil l  need 5.8 MB of available space on your hard

disk to install The Writing Center.

To install the program on your hard disk:
1. You cannot install The Writing Center while other

programs are running. Quit any applications that are

running and turn off all  virus checkers. Remove any virus-
checking INITs from your system folder.

2. Insert Disk 1 into a floppy disk drive.
3. Double-click on the Installer icon. After the welcome

screen appears, click on OK to continue. The installation

dialog box appears.
4. Make sure the drive selected is the one you want to use for

the instal lat ion. Cl ick on Instal l .  A dialog box wil l  appear

to show you the progress of the installation. Follow the
inst ruc t ions  on  the  screen ,  inser t ing  d isks  when  requested

to complete the installation.
5. When the "installation was successful" message appears,

asking ifyou want to quit or continue, click on Quit.
6. E ject  the  last  d isk  and store  the  d isks  in  a  safe  p lace.
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Installing the Program

Installing from CD-ROM

You'll need at least 2 MB available on your hard disk to install
The Writing Center program only. To install  the program and
the pictures, there must be between 8 MB and 12 MB available

on your system. The install program lets you choose  what  to
install.

1.
You cannot install The Writing Center while other
programs are running. Quit any applications that are

running and turn off all  virus checkers. Remove any virus-
checking INITs from your system folder.

2. Insert the CD labelled The Writing Center into your

CD-ROM drive.  A dr ive window opens on your desktop.
3. Double-click on the Installer icon. After the welcome

screen appears, click on OK to continue. The Easy Install
dialog box appears.
Make sure the drive shown is the location you want for the

installation.

If you want to install the program and the pictures, click
on Install.

If you want to install just the program or just the pictures,

click on Customize. Then click on the option you want
and click on Install.

A dialog box appears to show
installation.

you the progress of the

5. When the "installation was successful" message appears,
asking if you want to quit or continue, click on Quit.
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1
INTRODUCTION

GETTING HELP

Most people need some help when they try a new program.
With The Writing Center, you can get help information right on

the screen when using the program. (More detailed help
information is contained in the User's Guide. To order the

User's Guide, see the instructions on the next page.)

On-screen  he lp  g ives  you  qu ick  and  easy  access  to
information

about the program. There are two ways to  get  on-screen  he lp :

You  can  ge t  on-sc reen  he lp  about  what you are

currently doing by clicking on the Help button
whenever you see it on a screen or dialog box. For

example, cl icking on Help on the Main Menu wil l  give

you information about creating and opening

documents. After you read the information, click on

Done to go back to your work.

You can get help about any part of the program by

using the Help menu on the menu bar at the top of the

screen. The Help menu lists various parts of the

program. When you want to read information about a

certain part (like document layouts), just choose it from
the Help menu. The information appears inside a

window. After you have read the information, you can
read about  any  of  the  re la ted  i tems l i s ted  in  the  l i s t  box

at the bottom-left of the Help window, or click on
Done.

Consult your Macintosh and printer manuals to get answers to
questions about operating your Macintosh and printer.
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Ordering the User's guide

ORDERING THE USER'S GUIDE

The User's Guide contains complete information on all of the

program's features. It comes with a handy Ready Reference

Card that helps you find information fast. To order a complete

set of documentation, call The Learning Company at 1-800-

852-2255 or send your request with a check or money order for

$10 (payable to The Learning Company) to:

The Learning Company
6493 Kaiser Drive

Fremont, CA 94555
Attn: Customer Service
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2 Quick Lesson
Are you ready to work with your first document in The Writing

Center?  This lesson wi l l  get you off to a fast start in using

many of the program's most powerful features. Just follow the

step-by-step instructions. And don't worry about making

mistakes. You can "undo" just about anything in The Writing
Center. Just choose Undo from the Edit menu to undo the last

thing you did.

In this lesson, you will learn how to:
Open a saved document.

Work with pictures and words in the Heading and
Body of a document.

Change the page setup.
Save and print a document.

If you are running under At Ease, you must place the Sample
Report in your user folder before completing this Quick

Lesson. From the Finder, locate The Writing Center folder and
drag the Sample Report icon to your folder in the Documents

folder. If multiple users are using this Macintosh, copy the
Sample Report to each user's folder by holding down option
while you drag the icon to each folder.
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2 QUICK LESSON

STARTING THE PROGRAM

Since The Writing Center is already installed on your hard

disk, you can start the program immediately.

To start the program from the Finder:
1.  Double-cl ick on The Writ ing Center folder.

2. Double-click on The Writ ing Center icon or name.

To start the program from At Ease:
Click on The Writing Center icon in the At Ease Items
folder.

OPENING THE SAMPLE REPORT

When the Main Menu appears, click on Open Saved
Document.  A dialog box appears.  Cl ick on "Sample

Report" and then click on Open. The sample report is then

displayed in the document window on the screen.

S a m p l e  R e p o r t

A ON

center

T o d a y  I  l e a r n e d  h o w  u s e  a  n e w  p r o g r a m  o n  m y  M e c i n t o s h  c o m p u t e r .

I t ' s  c o l l e d  T h e  w r i t i n g  C e n t e r .  i t  d i d n ' t  t a k e  l o n g  t o  l e e r n  h o w  t o  u s e  T h e

w r i t i n g  C e n t e r ,  a n d  I  e s p e c i o l l y  e n j o y e d  l o o k i n g  t h r o u g h  t h e  m o r e  t h a n  2 0 0

| c o l o r e d  p i c t u r e s  t h o t  c o m e  w i t h  t h e  p r o g r a m .  w a s  a m a z e d

a t  h o w  e a s y  i t  i s  t o  a d d  p i c t u r e s  a n d  h o w  q u i c k l y  t h e  t e x t  i n  t h e  B o d y

P a g e  |  -  B o d y
t h e m  Y o u  c o n  e v e n  c o t a t e  o . c  a
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Parts of the Report

PARTS OF THE REPORT

The  sample  repor t  has  two  par ts ,  separated  onscreen  by  a

double dotted line: the Heading and the Body.

The Heading is a special area that can appear at the beginning

of a document. It goes across the width of the page. As text
and pictures are added, the Heading gets longer. In the

Heading, text can be typed over pictures, so you can create
s o m e very dramatic headlines.

The Body is the main part of the document and appears below

the Heading. The Body can have up to nine columns of text

and as many pages as your computer's memory can hold. In
the Body, text wraps around pictures.

O N

anter

T o d a y  I  l e a r n e d  h o w  t a  u s e  n  n e w  p r o g r e m  o n  m y  H a c i n t o s h  c o m p u t e r .

:  c o l l e d w r s t i n g  C e n t e r .  i t  c i d n ' t  t a k e  l o n g  t o  l e a r n  h o w  t o  u s e  T h e

w r i t i n g  C e n t e r ,  e n d  |  e s p e c i a l l y  e n j o y e d  l o s k i n g  t h r o u g h  t h e  m o r e  t h e n  2 0 0

c o l o r e d  p i c t u r e s  t h a t  c o m e  w i t h  t h e  p r o g r e m .  i  w e s  a m o z e d

e t  h o w  e e s y  i t  i s  t o  a d d  p i c t u r e s  a n d  h o w  q u i c k l y  t h e  t a x t B o d g

|  w r e p s  e r o u n d  t h e m  Y o u  c o n  e v e n  r e t a t e  o r

m h p  a  p i c t u r e ,  c h a n g e  i t s  s i z e ,  o r  c r o p

i t - r i g h t  t h e r e  o n  t h e  p a g e
Te  a i e m p h a s i s y o u r  w r a t i n g ,  y o u  e

u n d e r l i n e  s o m e  w o r d s ,  m o k e  o t h e r s

b i g g e r  e n d  b o l d e r ,  a n d  e v e n  h a v e  t e x t

t h a t  i s  c o l o r e d  i n s t e a d  o f  b l e c k .  B e f e r e  I

p r i n t e d  m y  r e p o r t ,  l  u s e d  C h e c k  S p e l l i n g  t o

f i n d  a n d  c o r r e c t  s p e l l l i n g  m i s t a k e s .

b e s t T h e  w r i t i n g  C e n t e r i s  l o o k i n g  a t  m y  f i n i s h e d

r e p o r t  o f t e r  p r i n t i n g  i t  c u t  o n  o u r  i m e g e w r i t e r  I l  w i t h  a  c o t o r  r i b b o n .  T h e

t e x t  a n d  c o l o r  p i c t u r e s  l o o k  s o  g o o d )

R e p o r t s  n a t  t h e  o n l y  t h i n g  y o u  c a n  c r e a t e T h e  W r i t i n g  C a o t e r

Y o u  c o n  m a k e  n e w s l e t t e r s ,  f i y e r s ,  f a n c y  t e t t a r h e s d s ,  g r e e t i n g  c a r d s ,  a n d

l o t s  m o r e .  m a y  p u t  l o g e t h e r  n e w s l e t t e r  a n d  h o v e  s o m e  f r i e n d s

c o n t r i b u t e  a r t i c l e s  i l l u s t r a t e d  w i t h  p i c t u r e s  f r o m  t h e  p r o g r o m .  W e  c e n

e v e n  u s e  p i c t u r e s  t h e t  c o m e  f r o m  o t h e r  p r o g r a m s  o r  w e r e  m e d e  w i t h  s

p o i n t  p r o g r a m .  T h e  o n l y  p r o b l e m  I  s e e  n o w  i s  h o w  t o  d e c i d e  w h o s e  t u r n  i t

u s e  T h e  w r i t i n g  C e n t e r .  H o w  w i l l  t h e r e  e v e r  t i m e  f o r  e l l  o f  u s  t o

u s e  # 1 ?

Printout of Unchanged Sample Report
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2 QUICK LESSON

WORKING WITH THE HEADING

The Heading of the sample report looks good, butyou can

make it look better. Try moving the picture, adding some

words, and aligning the text by following the steps below.

Moving the Picture
1. Go to the Heading by moving the I-beam pointer anywhere

in the Heading. Then click (press) the mouse button. Look
to the left of the bottom scrol l  bar. The words "Page 1-

Heading" there tell you where you are currently working in
the document.

2. Before you can move the picture of the books, you need to

"select" it (highlight it to show the program which text or

picture you want to change).
To select the picture:

Move the arrow pointer to the word Picture on the
menu bar. Hold down the mouse button to open the
menu.

Move the pointer down to highlight Work with Heading
Pictures and release the mouse button. A frame with

edit handles appears around the Books picture to show
that it is selected.

3. To move the picture:

Move the arrow pointer to the inside of the picture (not

on one of the edit handles). Hold down the mouse
button.

Drag the picture (by moving the mouse) to the left side

of the Heading. Then release the mouse button.

(Actually, only an empty picture placement box wil l

move as you drag the mouse. But as soon as you

release the mouse button, the picture will appear in the
box in the new location.)
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Working with the Heading

S a m p l e  Re p o r t  C C o

IAL REPORT ON

vriting Center
E d i t e d  b y

To d a y  I  l e e r n e d  h o w  t o  u s e  a  n e w  p r o g r e m  o n  m y  M a c i n t o s h  c o m p u t e r .

I t ' s  c a l l e d  T h e  W r i t i n g  C a n t e r .  I t  d i d n ' t  t a k e  l o n g  t o  l e a r n  h o w  t o  u s e  T h e

w r i t i n g  C a n t e r ,  a n d  I  e s p e c i e l l y  e n j o y e d  l o o k i n g  t h r o u g h  t h e  m o r e  t h a n

2 0 0  c o l o r e d  p i c t u r e s  t h a t  c o m e  w i t h  t h e  p r o g r e m .  I  w a s  a m a z e d

a t  h o w  e a s y  i t  i s  t o  e d d  p i c t u r e s  a n d  h o w  q u i c k l y  t h e  t e x t  i n  t h e  B o d y

I  w r a p s  a r o u n d  t h e m .  Y o u  c o n  e v e n  r o t e t e

o r  f l i p  a  p i c t u r e ,  c h a n g e  i t s  s i z e ,  o r  c r o p

Can you see all of the picture in the Heading? If not, point and
click on the picture again and position it SO that its placement

box is completely inside the Heading area. Release the mouse

button to place the picture where you want it.

Adding Text
Now add your name in the Heading tit le:

4. Move the I-beam pointer behind the "y" in "by" in the last

l ine of the Heading text. Click the mouse button. The

bl inking vert ical  l ine you see (it's called the "insertion

point") shows youwhere the next letteryou type will
appear.

5. Type your first name. Press shift while you type to make
capital letters. If you make a mistake, press delete| (or

backspace] ) to erase, and type again.

Aligning Text
The Heading title is now centered on the width of the page.

But it might look better on the right side of the page. To move

(realign) it, you'll need to check that the Ruler is displayed and
then select  the text .
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2
QUICK LESSON

6. To display the Ruler:
Point and click on the Edit menu and choose

Preferences.

In the dialog box that appears, click on Show Ruler to
check the box next to it .  While you are here, click on

Show Invisibles to check the box next to it, too. This

feature will show paragraph and other markers in your
document.

Click on OK. Notice that the Ruler now appears at the
top of the document window. You'l l  a lso see markers

in  the document -a J  to  show where return was

pressed,  a  where  tab was pressed,  and a  N where
the text ends in the Heading and Body.

7. Be sure the insertion point is sti l l  in the Heading. Then
point and click on the Edit menu and choose Select All Text

to select all the lines of text in the Heading.

8. To align (l ine up) the text on the right, cl ick on the Align

Right icon at the bottom of the Ruler. (The Al ign Right

icon is the third icon in the middle group of icons.) The
text moves and aligns on the right.

Sample Report

A l ignment  icons

SPECIAL REPORT ON
The writing Center

E d i t e d  b y  K i m l

T o d a y  I l e e r n e d  h o w  t o  u s e  a  n e w  p r o g r a m  o n  m y  M a c i n t o s h  c o m p u t e r .

I t ' s  c o l l e d  T h e  w r i t i n g  C e n te r.  I t  d i d n ' t  t a ke  l o n g  to  l e a r n  h ow  to  u s e  T h e

w r i t i n g  C e n t e r,  a n d  e s p e c i a l l y  e n j oye d  l o o k i n g  t h ro u g h  t h e  m o re  t h e n

2 0 0  c o l o re d  p i c t u re s  t h a t  c o m e  w i t h  t h e  p ro g r a m .  I  wa s  a m a ze d  9

P a g e  1  -  H e a d i n g
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Working with the Body

WORKING WITH THE BODY

Now that the Heading is finished, you can work on the Body of

the report. Since a picture is worth a thousand words, why not

add another picture to the report? And while you're at it, you

can crop, flip, and resize the picture to make it look just the

way you want. Then take a good look at the text in the Body.
It needs a bit of repair-but fixing spacing and spell ing errors

is a cinch with The Writing Center. And changing fonts, sizes,
and styles for just the right emphasis could hardly be easier!

Placing a Picture
1.  Go to the Body by cl ick ing anywhere in  the Body.  The

words "Page 1- Body" appear to the left of the bottom
scroll bar.

2. To choose a picture:
Choose Choose a Picture from the Picture menu.
Click on the down arrow in the scroll bar until you see

the People folder. Click on People and then click on

Open Folder to open that folder. The names of the

pictures in the folder appear on the right in the list box.
The first picture in the list appears on the left.
Scroll down to Teens and click on it to see the Teens

picture. Clicking on the names of pictures is a good
way to preview pictures. (To get to another part of a

long list in a picture list box more quickly than by

using the scroll bar, simply type a letter. For example,

you could type "t*" to quickly get to the Teens picture.)

Click on Place in Document to choose this picture. The

Teens picture then appears in the upper-left corner of
your screen. Notice that a frame with edit handles

appears  around the  p ic ture  to  show that  i t  i s  se lec ted.
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2 QUICK LESSON

3. Move the arrow pointer onto the picture, hold down the

mouse button, and drag the picture anywhere in the Body-

down, up, right, or left. The report automatically scrolls

when you move the picture to the top  o r  bo t tom edge  o f  the

document window.
4. Re lease  the  mouse  but ton  to  p lace  the  p ic tu re  on  the page.

S a m p l e  R e p o r t

Ed i ted  by  K im

i  l ea r ned  how to  use  a  new program on  my  Mac in tosh  computer.  I t ' s  ca l l ed
V ing  Center  I t  d idn ' t  take  long  to  lear n  how to  use  The  wr i t ing  Center,  end

y  en joyed  look ing  through  the  more  than  200 co lored
t h a t  c o m e  w i t h  t h e  p ro g r a m .  I  wa s  a m a ze d  9

osy  i t  i s  to  add p ic tures  and  how qu ick ly  the  text  in
t h e  B o d y  w r a p s  a r o u n d  t h e m .

Yo u  c a n  eve n  ro t a te  o r  f l i p

p ic tu re ,  change  i ts  s i ze ,  o r

c rop  i t  - -  r i g h t  t h e re  on  t h e

p a g e . s

Pa g e  1  -  B o d y

If you placed the picture beside text, notice that the words

moved out of the way to "wrap" around the picture. If you
p laced  the  p ic ture  outs ide  o f  the  page  marg ins ,  par t  o f  the

picture will be missing. Move it so that the entire picture is

inside the page margins.

5. When the picture is where you want it on the page, deselect

the picture by clicking anywhere in the document window
except on the picture. The frame around the picture

disappears.
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Viewing the Whole Document
Unless you p laced the  p ic ture  a t  the  end of  the  repor t ,  the

picture moved the text down. But you can't see the whole

report in the document window. How would you l ike to see a

reduced view of the whole page? It's easy to do, and it's a

good idea to get an overview of your document every once in a

while- -especially when you make a major change, such as

adding a picture.

6. Choose Page Preview from the Fi le menu. A reduced-size,

full-page view of your report appears in a dialog box.

P rev i e w  o f :  " S a m p l e  Re p o r t "  -  Pa g e

2EC

Reduced  S ize O  F u l l  S i ze Done

N e x t  P a g e Previous Page H e l p…

7. Cl ick on Done to return to the document window.
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Changing the Picture
Part of the fun of working with pictures is changing them. You
can crop a picture so that part of it is covered. You can also

flip a picture, and you can change its size and proportions.
And it's all  so easy!

8. Click on the Teens picture to select it. If you can't see the

whole picture, you might want to scroll the document by
clicking on one of the arrows at the ends of the scroll bar.

9.  To crop the picture:

Choose Crop Picture from the Picture menu. The

Teens picture appears in a dialog box with a frame and
four edit handles.

•
Drag the left or right edit handle toward the middle of

the picture. Crop either the girl or boy from the picture
SO that you have just one figure in the picture.

C ro p  P i c t u re

D o n e

C a n c e l

H e l p . .

D r e g  o n e  o r  m o r e  h a n d l e s .  T h e n  c l i c k  o n  D o n e .

Click on Done to see the cropped picture in your
document.

16



Working with the Body

10. To fl ip the picture:

Make sure the picture is stil l  selected. (Click on it if it
is not.)

Choose Fl ip Sideways from the Picture menu. The

figure in the picture will face the other way.
11. To resize the picture:

Make sure the picture is stil l  selected. (Click on it if it
is not.)

•
Drag any corner edit handle. The picture becomes

bigger or smaller proportionally.

Drag any side edit handle. The picture stretches or
shrinks disproportionately.

Sample Report15t tt 9eeO
U  7 7 e  w T T t m g  C e n e r .  T C  u r u n  t  t a k e  t u n g  t u  t e a r u  n u w  t u  u s e  7 7 7 E

Center,  and  I  espec ia l l y  en joyed look ing  through
t h a n  2 0 0  c o l o re d  p i c t u re s  t h a t  c o m e  w i t h  t h e

w a s  a m a z e d  9

a t  h ow  e a sy  i t  i s  t o  a d d

p i c t u r e s  a n d  h o w  q u i c k l y
t h e  tex t  i n  t h e  B o d y
w r a p s  a ro u n d  t h e m .  Yo u

c a n  e ve n  ro t a t e  o r  f l i p

p ic ture ,  change  i ts  s ize ,  o r  c rop  i t  -

r igh t  there  on  the  page .9
To  a d d  e m p h a s i s  to  yo u r  w r i t i n g ,  yo u

can  under l i ne  some  words ,  make  o the rs

a n d  b o l d e r,  a n d  e v e n  h a v e  t e x t  t h a t  i s  c o l o r e d  i n s t e a d  o f
[ P a g e  1  -  B o d y " k

Working with Text
There are several things wrong with the text in the Body of the
report. For one thing, there are two blank lines in the first

paragraph. For another, the spacing in the third paragraph is

wrong. And there is a spell ing error in there somewhere.
Here's how to fix things up and have a bit of fun with fonts, too.
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12. To remove the blank l ines, click in front of the "a" in "at"

(the first word after the blank lines) and press [delete] (or
backspace three times. The paragraph markers (which

show where return was pressed) disappear and the text

moves up.

13. To change the spacing in the third paragraph (scroll down if

necessary), click at the beginning of the paragraph (it begins

with "The best part...") and drag across the text to select it.

L ine-spac ing  icons

Sample Report
.J4

w re p s  a ro u n d  t h e m .  Yo u
c a n  eve n  ro t a te  o r  f l i p  a

* 1 1 1 1

p ic tu re ,  change  i ts  s i ze ,  o r  c rop
r i g h t  t h e re  o n  t h e  p a g e .q

To  a d d  e m p h a s i s  t o  yo u r  w r i t i n
can  under l i ne  some  words ,  make

bigger and bolder, and even heve text that is colored instead
b l a c k .  B e fo r e  p r i n t e d  m y  r e p o r t ,  I  u s e d  C h e c k  S p e l l i n g  t o  f i n d

c o r r e c t  s p e l l l i n g  m i s t a ke s .9
T h e  b e s t  p a r t  Q t  u s 1 0 g * 1 :  l o m l i n g  a l  r o l l

r e p o r t  a r t e r  o r i n t i n o o u 1  0 3 1  0 0 4 1  l i n u p e r i t e r  l  w i t h a c o l o r

and  co lo r  puc tures  lon t  60  j00g l

R e p o r t s  a r e  n o t  t h e  o n l y  t h i n g  yo u  c a n  c r e a t e  w i t h  T h e  Wr i t i n n

Page - Body

(You can also triple-click anywhere in the paragraph to

select it.) Then click on the Single Space icon at the

bottom of the Ruler. (The Single Space icon is the first

icon in the last group of icons on the right.) The text
changes to single-spacing.

14. To check the spelling in the report:

Click anywhere in the Body of the document.

Choose Check Spell ing from the Reference menu.
• In the dialog box that appears, make sure that there is

an X in the box next to Suggest Spell ing. If  it  is

unchecked, click on Suggest Spell ing.
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Working with the Body

Click on Start Checking. The program automatically
"reads" the report from top to bottom, including text in

the Heading and in the Body. When it  f inds word

that is not in its dictionary, it displays the word at the

top of the dialog box.

If the program displays your name, click on Add to add
this word to the TWC User Dict ionary.  (The next t ime

the program "reads" your name, it will recognize it.)

When the program displays the word "spell l ing," click

on the correct spelling of the word ("spelling") in the

list under Suggest Spelling (if it is not already

highl ighted).

S a m p l e  R e p o r t

3 1 4

S p e l l i n g  C h e c k e r

T h e e  Nr i t ina
l e s p e d

Wo r d :

p ictul  "spel l l ing"
Sk ip

e a sy  |  C h a n g e  To :
¡w r a p s   s p e l l i n g C h a n g e

i c h a n g
X  S u g g e s t  S p e l l i n g Change A l l
spel l inq Ÿ
spi l l ing

A d d

sp lay ing D o n e
spoi l ing

I  s p o o l i n g H e l p . .

i n s t e a d  o f  b l a c k .  B e f o r e  I

p r i n t e d  my  re p o r t ,  I  u s e d
eflli

Page 1  -  Body

Click on Change to change the spelling of the word in

the report.

When you see the message that no more misspelled
words were found, cl ick on OK. The word "spell ing"

will be highlighted in the report and spelled correctly.
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15. To change the font, size, and style of a word:

Locate the word "so" -the next-to-the-last word in the

third paragraph (scroll down if necessary). Double-
click on the word to select it.

Choose Font from the Text menu.
•

In the dialog box that appears, click on "Times" to

change the font. If you can't see "Times," scroll

through the list of fonts until you see it .  Then cl ick on

14 in the size box and on Bold, Italic, and Shadow in

the style box. Notice that the sentence in the Sample

box changes to reflect your choices.
Click on OK to return to the document window to see

how the word "so" looks now. Your changes made
quite a difference!

S a m p l e  R e p o r t

Font
S a m p l e

T h e  q u i e l  b ro u n  l o s  j u m p s  ove r  t h e  l a ny  d o g l h

F o n t S i z e

C
S t y l e ( s )

L o s  A n g e l e s 9
M o b i l e 0  P la in

M o n a c o X Bold O K

N e w  Yo r k
italic

C a n c e l
S a n  F r a n c i s c o 18 0 Under l ine

S y m b o l 24 0  O u t l i n e
8 Shadow Help.. .

T i m e s
D e n i c e . Strikeout

Cl ick  on  your  cho ices .  Then  c l i ck  on  0K .

Pa g e  1  -  B o d y

16. Now that you have finished editing the text, you may want

to hide the Invisible markers again. Choose Preferences

from the Edit menu and then uncheck Show Invisibles by
cl icking on it .  Then cl ick on OK.
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Working with Page Setup

WORKING WITH PAGE SETUP

You've worked in both the Heading and the Body of the report.

Now add the finishing touches by placing a border on the page.
And just for fun, experiment with a two-column report.

Adding a Page Border
1. Choose Page Setup from the File menu.

2. Cl ick on Page Border ( in the Page Layout box on the

bottom-left) in the Page Setup dialog box. The Page

Border dialog box appears.

Sample
Page Border

O K

Cancel

Help.

Border Sides Border Lines Border Style

X  Top Hairline
Z Bottom

O B lack

X Right
Single Line O Gray

O Double Line
X Left

O Light Gray
O Triple Line O Shadow

C l i c k  o n  yo u r  c h o i c e s .  T h e n  c l i c k  o n  O K .

3. To add a border on al l  four sides of the page, make sure

that all four boxes are checked under Border Sides. Then

click on the kinds of border lines and styles you want.

Notice that the border in the Sample box changes to reflect
your choices.

4. Cl ick on OK to return to the Page Setup dialog box. Then
click on OK to return to the document window to see the

page border.
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Creating Two Columns
Although most reports usually have one column of text, would
you like to see how your report would look in two columns?
It's simple! Here's how.

5.  Choose Page Setup from the F i le  menu.
6. Cl ick on 2 Columns ( in the Columns box at the bottom) in

the Page Setup dialog box.

ImageWriter
Pa p e r : ©  U S  Le t t e r

O  U S  L e g a l
O  A 4  L e t t e r
O  I n t e r n a t i o n a l  F a n f o l d

O  C o m p u t e r  P a p e r
C a n c e l

O r i e n t a t i o n Special Effects: X Tall  Adjusted
0 5 0  %  R e d u c t i o n

0  N o  G a p s  B e t w e e n  P a g e s

P a g e  L a y o u t C o l u m n s M a r g i n  S e t t i n g s

Document  Head ing 1  ©  1  C o l u m n Top 1.00

0  P a g e  N u m b e r s
X  L i n e  B e t w e e n  C o l u m n s

O  2  C o l u m n s
O  3  C o l u m n s

B o t t o m  1 . 0 0

O other  1
Lef t  1 .00

P a g e  B o r d e r …
R i g h t  1 . 0 0

C l ick  on  your  cho ices .  Then  c l i ck  on  OK.

7.  Cl ick on OK to see the Body of the report in two columns in
the document window. How does i t  look?

8. Before saving and printing your report, choose Undo Page

Setup from the Edit menu to return the Body to one
column.
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SAVING YOUR REPORT

Now that you've made all your changes to the report, it is

important to save the document. When you save your report
(or any document) on a hard disk or floppy disk, you're storing

it in a f i le that you can come back to any time you want. In
fact, it's a good idea to save your document often as you work

on it .  Then you won't lose your work even if  you turn the

computer off.

1. Choose Save As from the File menu.

2. In the dialog box that appears, type a new name for the
document. You won't want to save it  under the name

"Sample Report" because if you do, your new, changed
document will take the place of the original one already
saved on the disk. Then no one else will be able to do this

lesson with the original Sample Report document.

S a m p l e  R e p o r t
1 4 1 5

Po p - u p  m e n u
S a v e  D o c u m e n t

Wr i t ing  Center
D  H e l p  F i l e -  H a rd  D i s k

Current

D  M a i n  D i c  t i o n o r y
D  S a m p l e  R e p o r t

Lject
d isk

List  box C  T e m p l a t e s

G  T h e  W y t i n g  C e n t e r ™
D n i v e

.  T W C  P i c t u r e s S a v e

C h e c k  S p e l l i n g c a n c e l
T h e  b e s t

S a v e  d o c u m e n t  a s :

p r i n t i n g  i t  o u t K i m ' s  S a m p l e  R e p o r t
r e p o r t

H e l p . . o r  p i

look  so  good D  S a v e  a s  A S C I I  F i l e  ( Te x t  O n l y )
R e p o r t s Yo

I m a k e  n e w s l e t t e r s ,  f l y e r s ,  f a n c y  l e t t e r n e a d s ,  g r e e t i n g  c e r d s ,  a n d  l o t s  m o r e .

u t  t o g e t h e r  a  n e w s l e t t e r  a n d  h a v e  s o m e  f r i e n d s  c o n t r i b u t e  a r t i c l e s  i l l u s t r a t
P a g e  1  -  B o d y k J l

3. Click on Save to save the document in the folder shown in

the pop-up menu. To save it in a different folder, click on a

folder name in the list box or click on the pop-up menu and

choose another folder. To save it on a floppy disk, insert
the disk in the drive, make sure the disk name shows, and
then click on Save.
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PRINTING YOUR REPORT
Are you ready to see the results of all  your work?  Then print

your report to see what it looks l ike.

1. Choose Print from the File menu.

2. Cl ick on OK to start  pr int ing.

* **

Congratulat ions !  You've just produced your f irst document

with The Writing Center! Now you are on your own to explore

the program and create your own original documents. To learn

new things and discover more program features, experiment
with menus and dialog boxes in the program, or explore the

User's Guide. (To order the User's Guide, see Chapter l :

Introduction.) And whenever you need help, use the Help

menu or cl ick on Help in a dialog box.
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3 For At Ease Users
This  vers ion  of  The  Wr i t ing  Center  i s  des igned to  run  under  At

Ease ,  the  a l te r nat ive  in te r face  f rom App le  Computer.  Before

running The Writing Center under At Ease, however, the At Ease

Admin ist rator  must  run  the  program at  least  once f rom the  F inder

to change some sett ings.  I f  the program was  pre- insta l led  on  your

hard  d isk ,  the  program is  a l ready conf igured to  run  under  At  Ease

and you can sk ip  th is  step.

Since At  Ease can be set  to prevent  unauthor ized access to your

Mac intosh's  hard  d isk ,  the  Admin ist rator  shou ld  a lso  run  The

Wr i t ing  Center  f rom the  F inder  to  change the  defau l t  p ic ture

folder. Note: Users will be able to change the default picture

fo lder  i f  the  Admin is t ra tor  changes  the  At  Ease  Setup  to  a l low

user  to open f i les  anywhere on the hard d isk.

SETTING UP THE PROGRAM
If The Writing Center needs to be reinstalled, it must be
reinstalled by the Administrator, then set up to ensure that the

program runs properly under At Ease.

1. Reinstall The Writing Center as described in the instructions

provided by Apple Computer.

2. Start The Writing Center from the Finder by opening the The

Wr i t ing  Center  fo lder  and  doub le-c l ick ing  on  the  The  Wr i t ing
Center  i con .

3.  Set  the defaul t  p ic ture fo lder  preference as descr ibed in  the

following section.

4. Select Check Spelling from the Reference menu. This will
create the TWC User Dict ionary i f  one does not already exist.

5. Copy the Sample Report document, Checklists folder, and

Templates  fo lder  to  each user 's  fo lder.  These  fo lders are

located in  the  Documents  fo lder  wh ich  At  Ease  creates  on

your hard disk.
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SETTING THE DEFAULT PICTURE FOLDER

The default picture folder is the folder that is automatically

opened when users choose Choose a Picture from the Picture
menu. The default picture folder is set to ''Pictures,' the folder

of pictures that comes with The Writ ing Center. However, any

folder of pictures can be the default picture folder and you can

change it at any time. For example, you can choose a folder of

pictures from clip art collections or pictures created with paint

programs as long as they are in the PICT fi le format.

To set the default picture folder:

1. Start The Writ ing Center from the Finder by opening the

The Writing Center folder and double-clicking on the The

Writ ing Center icon.

2. Open the Edit  menu and choose Preferences. The

Preferences dialog box appears. The dialog box shows the
name of the default picture folder that the program is now

using.

P re fe re n c e s

Ruler
O K

X  S o u n d O Inches O P icas
0 Show Ruler O  C e n t i m e t e r s  O  P o i n t s Cancel
Show Invis ibles
X  C o n v e r t  C o l o r  P i c t u r e s  t o  B l a c k  &  W h i t e  o n  S c r e e n Help.

S e t  D e f a u l t  P i c t u r e  F o l d e r . . . "Pictures"

C l i c k  o n  yo u r  c h o i c e s .  T h e n  c l i c k  o n  O K .

2.  Cl ick on Set Default  Picture Folder.  Another dialog box
appears.
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Setting the Default Picture Folder

Set  Defau l t  P ic ture  Fo lder

Po p - u p  m e n u 6 Pictures
C Activities -HD Current

Animals disk

D  C o m m u n i t y Elect
Food Drive
0  Fun  and  Fan tasy

List box History Select
Lines and Shapes

C a  M a p s Open

. Miscel laneous
D Nature/Science

C a n c e l

- Nice for Headings Help..

Open fo lders  unt i l  the name of  the fo lder  you want
appears in  the smal l  (pop-up menu) box.  Then cl ick
on Select.

3. Cl ick on Drive (or Desktop) if  you need to change disk
drives. Use the directory pop-up menu (above the list box)
to find more folders. If al l  the folder and fi le names don't

fit in the list box, click on the up or down arrow to scroll
the contents until you can see them all.

In the list box, click on the folder you want, then click on

Open. The folder name appears in the closed pop-up menu
box.

5. When the name of the folder you want to have as the

default picture folder appears in the pop-up menu box, click
on Select. The Preferences dialog box now shows the name

of the folder you selected as the default picture folder.

6.  Cl ick on OK. Now when you use Choose a Picture,  the

program will automatically open the new default picture
folder.
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4 Troul eshooting
The items in bold below are problems you might encounter when using
The Writing Center.

The text below them contains possible solutions to the

problems. If you need more assistance or have any questions,
call our Customer Service Department at 1-800-852-2255.

INSTALLING THE PROGRAM
1.

Dur ing instal lat ion,  you see the message,  "There is  not  enough room
on the hard drive."

The installation process requires 5.8 MB of hard disk
space. Quit the installation program and remove or
compress some of the fi les on your hard disk. (You can

copy programs and files to floppy disks and then delete
them from the hard disk.)
Choose Control Panels from the menu.  Then choose

Memory and turn off  Vir tual  Memory.

2. The instal lat ion process has stopped.

Sometimes program such as a screen saver, virus detector, or

a compression utility might interrupt the installation process.
Cancel the installation.

Turn off or remove from your System folder al l  non-Apple

Control  Panel  devices (CDevs) and INITs.  I f  the instal ler

created a program folder, remove it from your hard disk

(drag it to the trash and empty the trash). Then restart your
computer, and start the installation process again.

(Remember to turn on or replace the CDevs and INITs after
you finish install ing the program.)
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RUNNING THE PROGRAM
3. The program is working very slowly.

The program runs more slowly when you have many pictures

or have long paragraphs in a document.

Remove some of the pictures from your document or break

your document into two parts. To split a document, copy a
section of the text and paste it into a new document. Place

the p ic tures  that  go with the text into the new document.

Then delete the copied text and its pictures from the

original document.

Break up the long paragraphs into smaller ones by inserting

Return-key presses.

4. A message appears that says, "Low on memory! The action you are
trying to perform may not work. Save the document and restart the
program."

All the internal memory (RAM) of your computer is used up.

If this message appears when trying to start theprogram,

close any other programs that may be open.
• If this message appears while you are working in the

program, there may be too many pictures in the document,

too many documents open, or too many different type
styles on one page.
a. Be sure to save your document.
b. Remove some pictures or split the document into two

parts. See Troubleshooting item 3.
C . Close some documents.

d. Remove some of the text style changes. There should
be  no  more  than  50  s ty le  changes  on  a  page .

e. Quit The Writ ing Center program and then open it

again to renew the program's memory buffer.
•

If a document is starting to print on a LaserWriter printer

when the alert message comes up, go to the Chooser dialog
box at the menu and turn off Background Printing. See

the manual that came with the printer for more information.
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5. Page Preview shows a blank page even though there is work on i t .

Your computer may be low on memory.  See Troubleshoot ing
item 4.

6. Message appears that the computer is out of disk space.

The program has a virtual-memory feature that uses your hard

disk or a f loppy disk as if  i t  were computer memory (RAM).

Th is  enab les  l ow-memor y  compute rs  to  hand le  l a rge r  documents .

Remove files from your hard disk to free more space.

7.
The Spel l ing Checker and the on-screen Help don't  work.

The "Main Dict ionary" and "Help Fi le" must be in The Writ ing
Center folder.

Check that those fi les are in The Writing Center folder. If

you cannot locate them, use Find from the Finder's File
menu to look for the fi les. When Find locates the fi les,

click on the file names to get more information about their

location. If this doesn't work, reinstall the program.

8. Help is not available in the program.

See Troubleshooting item 7.

9. Text or pictures stored on the Clipboard are lost.
Ifyou cut or copy text or a picture, it replaces the old

information stored on the Clipboard. The old information is

thrown away. The information in the Cl ipboard is also lost

when you turn off the computer.

Try using the Scrapbook (on the menu) to store cut or

copied information. It can store multiple cuts or copies and
saves the  in format ion  to  d isk  when the  computer  is  turned of f.

10. The Help balloons from System 7 interfere with the program.
Click on the balloon icon on the right side of the menu bar.
Then choose Hide Balloons.
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11.
The picture folder isn't  visible when sett ing the default  picture folder.

If you are using At Ease, you must run the program from the

Finder, not from At Ease. See Setting the Default Picture

Folder in Chapter 3:  For At Ease Users for instructions.

12. The message appears that says, "A User Dictionary could not be
created. You will not be able to add new words."

If you are using At Ease, the program was not set up properly

after it was reinstalled. See Setting Up the Program in
Chapter 3: For At Ease Users for instructions.

WORKING WITH TEXT
13. Select All  Text does not select the text in the entire document.

When you have a Heading and a Body in a document, Select
All Text only selects the text in the section where the insertion

point is.

Click in the other section of the document, and choose

Select All Text to select the text in that part of the

document-the Heading or the Body.

14. Text or numbers do not line up uniformly with Tabs.
Choose Preferences from the Edit  menu. Cl ick on Show

Invisibles to show the hidden Tab and paragraph markers.
Look at the markers to be sure each line has the same

number of Tabs. If not, select the entire section and reset

the Tab stops.

15. The insertion point cannot be placed in another column or blank
space.

You can only place the insertion point with the mouse or arrow

keys where text characters, spaces, or blank lines already exist.

If the space is empty (contains no key presses), you must

use Return-key presses, Tabs, or the spacebar to move the

insertion point to the blank area.
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Make sure that the area is not filled with a picture that is

cropped to be all  white. To do this in the Heading, choose

Work with Heading Pictures from the Picture menu to select

any pictures that might be there. In the Body, move the

I-beam pointer over the area. If it changes to an arrow,

click the mouse and the picture will be selected. The

picture can then be moved or deleted.

16. The insertion point or text is not visible in the Heading.

The insertion point or text may not be visible through a picture.

Click in the Heading to be sure the insertion point is there.

Drag the I-beam pointer through the pictures to highlight

any text placed over them.

Choose Select All Text at the Edit menu to highlight the

text. Then go to Color on the Text menu and change the

color of the text, so that it is more visible through the

pictures.

17. You removed some text  you wanted to  save or  you per formed some
function that you did not want to and want to go back.

To take back a change, you can choose Undo (  (8 Z )

from the Edit menu. If you undo a change and then decide

you want i t  after  a l l ,  you can choose Redo ((% z)  from
the Edit menu to make the change again. (Undo changes to

Redo after you choose it. Redo changes back to Undo
w h e n you make another change).

18. The line spacing of an entire paragraph changed when changing
highl ighted text  from single- to double-spacing.

Single/double-spacing, as well as text alignment, paragraph

marg ins ,  and borders  around text ,  a re  paragraph-based funct ions .

Press return at the end of the sentence or text you want to

change to define the end of the paragraph.
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19. A text border remains after you delete the text in the border.
With the insertion point inside the border, uncheck the

border sides in the Text Border dialog box.

20. The text border of a paragraph that flows across two or more
columns only shows in one column.

It is best not to add borders to text that flows across columns.

With the insertion point in the paragraph, uncheck all

border sides in the Text Border dialog box. Break the big

paragraph into smaller ones (by pressing  return that don't

span columns. Then add borders around the paragraphs.

21. The text at  the bottom of the page(s) of  the document has moved.

The program's page numbers occupy the bottom line of each

page. Any text on that l ine wil l  move to the next page or
co lumn when page numbers are added.

Check the format of text after adding page numbers to your
document.

Add page numbers to a document before adding text or

pictures.

WORKING WITH PICTURES

22. Choosing Choose a Picture does not open any picture folder.
You must set the default picture folder in the Preferences

dialog box from the Edit menu to open a picture folder.

If you are using At Ease, see Setting the Default Picture
Folder in Chapter 3: For At Ease Users for instructions.

23. A Heading picture can't  be selected.

Click in the Heading before trying to work there. Choose
Work with Heading Pictures from the Picture menu. If

there are two or more pictures in the Heading, hold down

shift  and cl ick on the pictures you don't want to work on

to  dese lec t  them.
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24. A picture in the Heading completely covers up text and pictures in
the Heading.

A picture dragged from the Body to the Heading does not act

like a Heading picture and covers up text and pictures in the

Heading. Don't drag pictures from the Body to the Heading.
Drag the picture back into the Body or delete it.
To move

picture from the Body to the Heading, cut or
copy and paste it.

25.
When choosing Work with Heading Pictures to work on one picture,
all the pictures in the Heading are selected.

Hold down shift  and cl ick on the pictures you don't  want
to work on to deselect them.

26. Text shows through a picture and does not wrap around a picture.

You are working in the Heading where text does not wrap
around pictures.

Use (tab spacebar or return I to move text away
from pictures in the Heading.

If you want to see the text over the picture, try changing the

color and style of text to make it more visible through a
picture.

If you want the text to wrap around the picture

automatically, cut and paste the text and then the pictures

from the Heading to the Body of the document. Then

remove the blank Heading by unchecking (cl icking on)

Document Heading in the Page Setup dialog box.

27.
When changing a document's page margins or page orientation (from

landscape to portrait or vice versa), some of the pictures disappear.

When the page margins change, pictures near the edge of the
page may be hidden in the margin.

Choose Page Setup from the File menu and change the

page margins to zero. Move the exposed pictures in your

document away from the edges of the page. Then return
the page margins to their original settings.
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28. A picture doesn't move when the text around it is moved or
reformatted.

Pictures do not move with text in The Writ ing Center.  Plan

your documents from the top down to avoid problems.
In the Body, it is best to place and move pictures after

formatt ing text in the Body.

29. When working with a picture, it loses clarity.

Try using Resize to change the picture to its original size,
or remove it and then place it again.

30. A picture (graphic) f i le can't  be chosen at the Choose a Picture dialog
box.

The Writing Center only accepts pictures from paint programs
that have been saved in the formats cal led PICT1 and PICT2.

To bring fi les created in any other format (such as TIFF or

EPS, etc.) into The Writing Center, paste them into the
Scrapbook or Clipboard, which convert images into PICT
files.

PRINTING DOCUMENTS
31. When printing a document, a message warns that the system is "out

of memory" and printing stops.
If you are printing on a Laser Writer printer, choose the

LaserWriter printer, then turn off Background Printing in

the Chooser dialog box.

32. Printing is very slow.

In the Picture Options box in the Print dialog box from the

File menu, choose Standard Quality Grays or Best Quality

Grays instead of Leave Alone.
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33. The edges of  a  document  are lost  when pr int ing a  document  on a
Laser Writer printer.

Use a margin of at least 0.5" (half an inch) on all sides of
your documents if you plan to print them on a LaserWriter

printer. To do this, choose Page Setup from the Fi le menu

and change the margin settings to be greater than 0.5".
Then cl ick on OK.

Whenever the selected printer is changed in the Chooser

dialog box, be sure to go to Page Setup to check the
settings. Then cl ick on OK. This needs to be done

individually for every document started before the printer
was changed, and for open documents that were saved with

different page-setup settings.

34. The colors in a printed document do not match the colors onscreen.

The Image Writer II  printer can only print 8 of the 16 colors

used by the program for the pictures and text. These colors

are: red, orange, yellow, green, blue, magenta, purple, and

black. Light and medium gray text or picture color wi l l  not

print out on the DeskWriter, Image Writer I I ,  or StyleWriter
printers.

35. When trying to print with a color ribbon on an ImageWriter
printer, the entire document prints in the wrong color.

Make sure the ribbon cassette is properly seated in your
printer (pushed in place). See the manual that came with

your printer for more information.

Turn the printer off and then on again.

SAVING DOCUMENTS
36. You see a  message that a document you are opening is "locked" and

"you will not be able to save any changes."

Files created with The Writing Center can be locked to prevent

users from accidentally saving over them or deleting them.
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Use Save As to save edits you make to locked fi les.

If you want to unlock the files, at the desktop highlight the

fi le name, and choose Get Info from the Fi le menu. Then
click on the Locked box to uncheck it.

37. You see a message that there "was a problem saving (file is locked).
The Save command has been cancelled."

See Troubleshooting item 36.

38. An existing file was replaced when saving a new document with a
different capitalization of an existing file name.

Whenever you save a document twice with the same name (in

the same folder on the same disk), the new document replaces

the existing one on the disk, even if the name has a different
capitalization.

To keep the existing fi le, save the new document under a

name that differs from the existing file name by at least one
character.

39. The Heading of a document disappears when the document is saved
in the text-only (ASCII) format.

Only the text in the Body is saved when a document is saved in

the text-only (ASCII)  format.

To save Heading text, move it to the Body before saving in
the text-only format.

If you have any questions, call our Technical Support

Department at  1-800-852-2255.
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CUSTOMER SERVICE

We are proud of  the specia l  re lat ionship we have with many

satisf ied parents and teachers. I f  you have a problem, a question, or

a suggestion, please cal l  our Customer Service Department at 1-800-
852-2255 or  1-510-792-2101.

The Learning Company warrants to the or ig inal  purchaser only that
the software program wi l l  per form in accordance with the

descr ipt ions in  th is  Quick Reference when used with the specif ied
equipment.

This  warranty is  in  l ieu of  a l l  other warranties,  whether oral  or

wr i t ten,  expressed or  impl ied.  Any impl ied war rant ies ,  inc lud ing

those of merchantabil ity and fitness for a particular purpose, are

l imited in duration to 90 days from the date of purchase of this
product.

The Learning Company shal l  not  be l iable  for  inc identa l  and/or

consequential  damages for the breach of any expressed or impl ied

warranty including damage to property and, to the extent permitted

by law,  damages for  personal  in jury  even i f  The Learn ing Company

has been advised of the possibi l i ty of such damages. Some states do

not al low the exclusion or l imitat ion of incidental  or  consequential
damages or  l imitat ions on how long an implied warranty lasts, SO the

above l imitat ions or  exclus ion may not  apply  to  you.

This warranty shal l  not be appl icable to the extent that any provision

of this warranty is prohibited by any federal ,  state,  or municipal  law

which cannot be pre-empted.  This warranty gives you specif ic  legal

r ights and you may also have other r ights which vary from state to
s t a t e .

Unauthorized reproduction, adaptation, distr ibution, per formance, or

display of this document, the associated computer program, or the
audiovisual  work is  str ic t ly  prohib i ted.
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The Learning Company®

Word Finder
Electronic Thesaurus

C o n g r a t u l a t i o n s  o n  yo u r  p u rc h a s e  o f  T h e  Wr i t i n g  C e n te r  ™ ,  o n e  o f  t h e  m o s t  a c c l a i m e d ,  a n d

easy-to-use ,  wr i t ing  products  fo r  s tudents ,  fami l ies ,  and  soc ia l  g roups .

A  ve r y  i m p o r t a n t  c o n c e p t  w i t h i n  t h e  d e s i g n  o f  T h e  Wr i t i n g  C e n te r  i s  t h e  o n - l i n e  a c c e ss  to  a

va r i e ty  o f  re fe rence  works .

As  an  in t roduc tory  bonus ,  we  want  to  o f fe r  you  an  exc i t ing  add i t ion  to  your  on- l ine  re fe rence

l ibrary.  Word F inder  is  an  e lec t ron ic  thesaurus  conta in ing  220,000 synonyms.  Wi th  Word F inder

y o u  c a n  f i n d  t h e  r i g h t  w o r d  f o r  y o u r  t h o u g h t  w i t h o u t  t a k i n g  y o u r  h a n d s  o f f  t h e  k e y b o a r d  o r  y o u r

eye s  o f f  t h e  s c re e n .  J u s t  h i g h l i g h t  wo rd  a n d  p o p  u p  a  w i n d ow  w i t h  a  l i s t  o f  a l t e r n a te  wo rd s

w i t h  s i m i l a r  m e a n i n g .  P u t  t h e  c u r s o r  o n  t h e  w o r d  y o u  w a n t  o n  t h e  l i s t  a n d  d o u b l e - c l i c k  .  T h e  n e w

word  i n s tan t l y  rep laces  th e  o ld  word  i n  th e  docu men t ,  even  re ta in in g  th e  ex ac t  p u n c tu a t ion ,

cap i ta l izat ion,  font ,  s ize ,  and sty le .

Wo u l d  yo u  l i ke  t o  d o  a  l i t t i e  l a n g u a g e  ex p l o r a t i o n ?  H e re ' s  h ow :  U s e  Wo rd  F i n d e r ' s  l o o k- u p
feature .  Look  up  synonyms for  any  word  that  i s  d isp layed in  the  synonym window.  By  repeat ing

th is  p rocess  you  can  exp lo re  the  r i chness  o f  the  Eng l i sh  l anguage  r igh t  a t  your  keyboard .

Word Finder is  being offered to The Writ ing Center  users for  $19.95.

Word F inder  is  va lued at  $59.95.  That  is  a  $40.00 sav ings !

To  o r d e r  y o u r  c o p y  t o d a y,  p l e a s e  c a l l  u s  a t 1-800-852-2255.

Your  V ISA or  MasterCard order  wi l l  be  qu ick ly  processed over  the  phone.  I f  you prefer  to  order

t h r o u g h  t h e  m a i l ,  p l e a s e  t a k e  t h e  t w o  s i m p l e  s t e p s  l i s t e d  o n  t h e  o t h e r  s i d e  o f  t h i s  o f f e r  a n d  m a i l

i n  yo u r  o rd e r  t o d ay.

As  a lways ,  every  product  f rom The  Learn ing  Company  comes w i th  a  30-day  100%-sat is fac t ion

guarantee .  I f  for  any  reason you  are  not  sat is f ied  w i th  Word  F inder,  we  w i l l  g lad ly  fu l ly  re fund
yo u r  p u r c h a s e  p r i c e .

O f f e r  i s  v o i d  w h e r e  p r o h i b i t e d  b y  l a w,  b y  P l e a s e  a l l o w  4 -  6  w e e k s  f o r  d e l i v e r y .
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To order a complete set of documentation (User's Guide

and Ready Reference Card) for  The Writ ing Center,
call 1-800-852-2255 or send your request with a check or

money order for $10 (payable to The Learning Company) to:

The Learning Company
6493 Kaiser Drive

Fremont,  CA 94555
Attn: Customer Service


